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1. Dulezité

Tato elektronickd uZivatelskd prirucka je
uréena pro kazdého uZivatele tohoto monitoru
Philips. Pred pouZzivdnim monitoru si prectéte
tuto uZivatelskou prirucku. Obsahuje ddlezité
informace a poznamky k pouzivani vaseho
monitoru.

Zaruka Philips je platnd, pokud je vyrobek
pouzivdn pro navrzenou potrebu v souladu

s ndvodem a po prilozen( origindlu faktury
nebo pokladnim dokladem, oznacujicim datum
ndkupu, jméno prodejce a modelové a vyrobnf
¢islo vyrobku.

1.1 Bezpecnostni opatreni a Udrzba

) Varovani

PouZitf kontrol, Uprav nebo postupt jinym
zpUsobem nez je stanoveno v této dokumentaci
muZe vést k ohrozenf Sokem, elektrickym a/
nebo mechanickym rizikim.

Prectéte si a dodrzujte tyto instrukce pri

zapojovani a pouzivani vaseho PC monitoru.

Pouzivani

*  Nevystavujte monitor pffmému slune¢nimu
zérenf, velmi silnym jasnym svétldm a
udrzujte jej mimo dosah jinych zdroju tepla.
Dlouhé vystaveni tomuto typu prostredf

muze mit za ndsledek zménu barev a
poskozeni monitoru.

»  Odstrarite veskeré predméty, které by
mohly spadnout do vétracich otvord nebo
zabranit dostatecnému chlazeni elektroniky
monitoru.

*  Nezakryvejte vétracl otvory ve skifice.

*  Umlistéte monitor na takové misto, ze
kterého bude elektrickd zdstrcka a zdsuvka
snadno pristupna.

* Jestlize jste vypnuli monitor odpojenim
napdjectho kabelu nebo kabelu napdjectho
adaptéru, pred pripojenim kabelu pockejte
6 sekund, aby monitor fungoval normdiné.

* Vzdy pouzivejte napdjeci kabel schvéleny
spole¢nosti Philips. Pokud napd jeci kabel
chybi, obratte se na nejblizsi servisnf
stredisko. (Viz informace o strediscich
zékaznické péce)

*  Béhem pouZivani nevystavujte monitor
nadmémym otrresim nebo ndrazim.

*  P¥ pouZivdni nebo premistovani do monitoru
nekopejte a zabrarite pripadnému padu.

Udrzba

*  Aby byl monitor chrdnén pred moznym
poskozenim, nevyvijejte na panel LCD
nadmeémy tlak. Pri premistovani zvedejte
monitor za rdm; pfi zvedani monitoru
nesahejte rukou nebo prsty na panel LCD.

* Nebudete-li monitor dels{ dobu pouzivat,
odpojte jej ze zdsuvky.

* Pred ociSténim mime navihéenym
hadrfkem monitor odpojte ze zdsuvky.
Je-li vypnuté napdjent, Ize obrazovku otrit
suchym hadrikem. K &isté&ni monitoru nikdy
nepouzivejte organickd rozpoustédla, jako
napfiklad alkohol nebo Eisti¢e s obsahem
¢pavku.

» Zabrarite nebezped( Urazu elektrickym
proudem nebo trvalého poskozenf
monitoru a chrarite monitor pried prachem,
destém, vodou nebo nadmérné vihkym
prostredim.

* Pokud dojde k namoceni monitoru, co
nejdrive jej osuste suchym hadrikem.

* Vnikne-li do monitoru cizf ldtka nebo voda,
ihned vypnéte napdjeni a odpojte napdjecl
kabel. Odstrarite cizf ldtku nebo vodu
z monitoru a odeslete jej do servisniho
strediska.

*  Monitor neskladujte ani nepouZzivejte
na mistech vystavenych teplu, pfimému
slunecnimu zéreni nebo extrémnim
teplotdm.

*  Chcete-li zachovat optimdlni vykonnost
monitoru a prodlouZit jeho Zivotnost,
pouzivejte jej na misté, které splfiuje
nasledujici rozsahy teplot a vihkosti.



+ Teplota: 0-40°C 32-95°F
*  Vlhkost: 20-80% relativni vihkosti

«  DULEZITE: Ped ponechanim monitoru
bez dozoru vzdy aktivujte sporic obrazovky.
Bude-li na vasem monitoru zobrazen
nemeénici se staticky obsah, vzdy aktivujte
aplikaci pro pravidelnou obnovu obrazovky.
Dlouhodobé neprerusované zobrazenf
nehybného nebo statického obrazu mize
zpuUsobit , vypaleni" obrazovky, rovnéz
zndmé jako ,dosvit" nebo ,,zobrazeni
duchd”.

,Vypaleni*, ,dosvit" nebo ,,zobrazen{
duchl" je dobre zndmy jev u technologie
panelt LCD. V mnoha pripadech ,,vypdleni,
,, dosvit" nebo ,zobrazeni duchd" postupné
zmizf po urcité dobé mimo provoz.

) Vystraha
Véazné priznaky ,vypdleni*, , dosvitu" nebo

ok

,,zobrazeni duchd' nezmizf a nelze je opravit. Na
vyse uvedené poskozen( se nevztahuje zdruka.

Servis

o Kryt pldsté maze oteviit pouze kvalifikovany
servisni pracovnik.

* Pokud je pro opravu vyzadovédna
dokumentace nebo integrace, obrat'te se
na nejblizsi servisnf stredisko. (Viz kapitola
, Stredisko zakaznické péce')

* Informace o prevazeni najdete v ¢ésti
,, Technické Udaje".

*  Neponechdvejte monitor v auté nebo v
zavazadlovém prostoru auta na primém
slunci.

€& Poznamka

Pokud monitor nefunguje spravné nebo pokud
si nejste jisti, jaké kroky je tr'eba provést po
proveden{ pokynt v této prirucce, obratte se na
servisntho pracovnika.

1.2 Vysvétleni zapisu

Nasledujici pododdily popisujf zpUsob zdpisu,
ktery se pouzivd v této prirucce.

Poznamky, upozornéni a vystrahy

Na strdnkdch této prirucky mizete narazit na
text, ktery je opatfeny symbolem a je vytistén
tucné nebo kurzivou. Takové useky obsahujf
pozndamky, upozornénf a vystrahy. Jejich pouzitf
je nasledujict:

€& Poznimka

Tento symbol oznacuje dllezité informace a
ndvrhy, které poméhajf Iépe vyuzit pocitacovy
systém.

© Upozornéni

Tento symbol oznacuje informace, které
objasniuji, jak se vyhnout moznému poskozenf
zafizeni nebo ztrdté dat.

D Vystraha

Tento symbol oznacuje nebezped( télesného
ubliZzenf a vysvétluje, jak se danému problému
vyhnout.

Nekteré vystrahy se mohou objevit v riizné
podobg a nemusi byt uvozeny symbolem.V
takovém pripade je konkrétni vyznaceni vystrahy
naf{zeno Uradem pro regulaci.



1.3 Likvidace produktu a obalového
materialu

Likvidace elektrickych a elektronickych
zarizeni - WEEE

This marking on the product or on its
packaging illustrates that, under European
Directive 2002/96/EC governing used electrical
and electronic appliances, this product may
not be disposed of with normal household
waste.You are responsible for disposal of

this equipment through a designated waste
electrical and electronic equipment collection.
To determine the locations for dropping off
such waste electrical and electronic, contact
your local government office, the waste disposal
organization that serves your household or the
store at which you purchased the product.

Your new monitor contains materials that can
be recycled and reused. Specialized companies
can recycle your product to increase the
amount of reusable materials and to minimize
the amount to be disposed of.

All redundant packing material has been
omitted. We have done our utmost to make the
packaging easily separable into mono materials.
Please find out about the local regulations on
how to dispose of your old monitor and packing
from your sales representative.

Recycling Information for Customers

Your display is manufactured with high quality
materials and components which can be
recycled and reused.

To learn more about our recycling program
please visit www.philips.com/about/sustainability/
recycling.



http://www.philips.com/about/sustainability/recycling
http://www.philips.com/about/sustainability/recycling

2. Sestaveni monitoru 2] Namontujte stojanek podstavce

1.

2.1 Instalace

El Obsah krabice

g%art

PHILIPS

VGA Zvukovy kabel (247E3LH)

Umistéte monitor obrazovkou dold na
meékky a hladky podklad, aby nedoslo k
poskrabdni obrazovky.

Uchopte stojdnek podstavce obéma
rukama a pevné zasurite do sloupku
podstavce.

(1) Opatmeé pripevnéte podstavec ke
sloupku podstavce tak, aby zdpadka
zajistila podstavec.

(2) Prsty utdhnéte Sroub na spodnf strané
podstavce a pevné zajistéte podstavec
ke sloupku.




Bl Pripojeni k pogitadi
Model 247E3L:

PHILIPS

@ Vstup stiidavého napdjent

© VstupVGA

© Vstup DVI-D

O Zimek proti krddezi Kensington

Model 247E3LH:

PHILIPS

@ Vstup stiidavého napdjent
© VstupVGA

© Vstup HDMI

O Vstup zvuku

© Vystup zvuku
@ Zimek proti krddeZi Kensington

Model 247E3LPH:

PHILIPS

°
§
el
 —
@ Vstup stiidavého napdjent
© VstupVGA
© Vstup HDMI

O Vystup zvuku HDMI
© Zimek proti krddeZi Kensington

Pripojeni k pocitaci

1. Pevné pripojte napdjeci kabel k zadnf strané
monitoru.

2. Vypnéte pocitac a odpojte jeho napdjeci
kabel.

3. Pripojte signdlovy kabel monitoru do video
konektoru na zadnf strané pocitace.

4. Zapojte napdjeci kabel pocitace a monitoru
do nejblizsi zasuvky.

5. Zapnéte pocita¢ a monitor: Jestlize se

na monitoru objevi obraz, instalace je
dokoncena.



2.2 Ovladani monitoru

~

1] Popis vyrobku z celniho pohledu
Model 247E3L:

Model 247E3LH:

/v

(54

/A 1/ < /0K [0)

| [\ I I
(6] © 6 o o

Model 247E3L (model 1A):

(5]
/v /A 17/4 /0K [0}

I I [\ I I
(7] (6] ©O ©6 0 o
o o [Sourk ZAPNUT( aVYPNUT(
napajeni monitoru.

Slouzi ke vstupu do nabidky
Slouzi k ndvratu na predchozf
o < drovert OSD.
Slouzi k dpravé nastavenf
o 1 hlasitosti reproduktoru.
© | A V¥V [Sloui k Upravdm nabidky OSD.
Slouzi ke zméné zdroje
6 9 vstupniho signdlu.
Smartlmage Lite Lze vybrat
néktery ze Sesti rezimd: Standard
o @ (Standardni), Internet a Game
(Hra).

(5} Model 247E3LPH:
@7/7/}“ [} /oK [0} o4
I I [\ I I
(7} (6} o 0 ) 1) /v ©/A SENSOR/ 4 /0K 0]
I I [\ I I
_ _ (7] (6] © O (2] o
o o Slouzi k ZAPNUTI a VYPNUTI
napajent moniort. © o [SoulkZAPNUTIavYPNUTI
0 /0K Slouzi ke vstupu do nabidky napdjeni monitoru.
OsD. © (=, Ok Sou ke vstupu do nabidy
) < Slouzi k ndvratu na predchozi OsD.
drovefi OSD. 0 <« Slouzi k ndvratu na predchozf
o F  |Zména formatu zobrazeni drovert OSD.
O-  |Nastaven( Grovné jasu. Slouzi k nastaven( Urovné
© | A V¥V [SlouZi k dpravdm nabidky OSD. O | SENSOR snimace pro automatické
Slous ke & 7droi ovladani podsvicen.
ouzi ke zméné zdroje
0o 2) vstupniho signdlu. ) © | A V¥V [SlouZik dpravém nabidky OSD.
[ |Zmena formdtu zobrazenf 0 © \S/Is(‘ELIJI;IIIIﬂeoZéI:giZ’IIeudeIe
Srvnartltnag% I'It.e ng \/}fbrat Smartlmage Lite Lze vybrat
@ @ ?Setk;edryréi Ose/;? ::ZLmu.GStrc)andard Q@ = néktery ze Sesti rezimd: Standard
anaardny, fntermet a Same (Standardni), Internet a Game
(Hira). (Hra).




Bl Popis zobrazeni funkci na obrazovce Model 247E3LPH:

1 Oon
Power Sensor =

Input

-
—7

Co je nabidka na obrazovce (OSD)?

Funkcf nabidky obrazovky (On-Screen Display,
OSD) jsou vybaveny viechny monitory

LCD Philips. Umozriuje koncovému uzivateli
upravovat vlastnosti obrazovky nebo vybirat

funkce monitoru prfmo prostrednictvim Iq Audio
zobrazeného okna s pokyny. NiZe je uveden
priklad piflemného rozhranf obrazovky: 1D

v

Model 247E3L:

Zakladni a jednoduché pokyny k ovladacim
tlaéitkam

Ve vySe uvedené nabidce obrazovky OSD
muzete stisknutim tlacitek ¥ A na prednim
rémecku monitoru pohybovat kurzorem a
stisknutim OK potvrdit vybér nebo zménu.

Picture Format - Wide Screen

Brightness < PRERERIID 100

@ Contras T
Color
SmartContrast - Off
Language

. ' 0SD Settings

Model 247E3LH:




Nabidka OSD

NiZe je uveden celkovy pohled na strukturu
OSD. Tento prehled mlzete vyuzit, budete-li
chtit pozdé&ji prozkoumat rliznd nastavent.

Main menu

Power Sensor

Input

Picture

Audio

Color

Language

OSD Settings

Setup

Sub menu

L

On — 04
off
(available for selective models)

VGA
DVI (available for selective models)

HDMI 1 (available for selective models)

HDMI 2 (available for selective models)

Picture Format — Wide Screen, 4:3
Brightness — 0~100
Contrast — 0~100
SmartResponse  —— Off, Fast, Faster, Fastest
SmartContrast — On, Off
Volume — 0~100 (available for selective models)
Stand-Alone — On, Off
Mute — On, Off
Color Temperature — 650K, 9300K
sRGB
User Define Red: 0~100

E Green: 0~100

Blue: 0~100

English , Espafiol, Frangais, Deutsch, Italiano,

Portugués, Pycckuii, B #ER L, Tiirkge

Horizontal — 0~100

Vertical — 0~100
Transparency — Off,1,2,3,4

OSD Time Out — 5s, 10s, 20s, 30s, 60s
Auto

Power LED — 0,1,2,3,4
Over Scan — On, Off (available for selective models)
H. Position — 0~100

V. Position — 0~100
Phase — 0~100
Clock — 0~100
Resolution Notification — On, Off
Reset — Yes, No

Information

El Poznimka k rozligeni

Tento monitor je urcen pro optimdlni vykon pr
nativnim rozliseni 1920x1080 pri 60Hz. Kdyz je
monitor zapnut pri jiném rozliseni, na obrazovce
se zobraz( vystraha: Use 1920x1080@60Hz for
best results (Pro optimélni vysledek pouzijte
rozliseni 1920x1080 pri 60Hz).

Zobrazovan( vystrahy na nativnf rozlisenf Ize
vypnout v ¢dsti Nastaveni v nabidce OSD.

Bl Fyzické funkce
Naklon




2.3 Demontaz stojanku podstavce

El Demontis stojanku podstavce

Nez zacnete demontovat podstavec monitoru,
postupujte podle pokynt nize, aby se zabranilo
jakémukoli moznému poskozeni nebo zranént.

1. Umistéte monitor obrazovkou dolt na
meékky podklad, aby nedoslo k poskrdbénf
obrazovky.

2. Podle ndsledujicich pokyn oddélte stojanek
podstavce od sloupku podstavce:

1) Prsty uvolnéte Sroub na spodni strané
Y p
podstavce.

(2) Opatrnymi pohyby nahoru a dold
uvolnéte zdpadku, kterd zajistuje
podstavec, a stdhnéte podstavec ze
sloupku.




3. Optimalizace Obrazu

3.1 Smartimage Lite

El Cojeto?

Funkce Smartimage Lite nabizi scéndre, které
optimalizujf zobrazenf rdznych typd obsahu a
dynamicky zlepSuje jas, kontrast, barvy a ostrost
v redlném case. Funkce Philips Smartimage Lite
prindsi optimalizované zobrazeni monitoru

bez ohledu na to, zda pracujete s aplikacemi,
prohlizite obrdzky nebo sledujete video.

Bl Pro¢ to potiebuii?

Protoze chcete sledovat monitor, ktery

prindsi optimalizované zobrazen( vsech vasich
oblibenych typl obsahu. Software Smartimage
Lite dynamicky upravuje jas, kontrast, barvy a
ostrost v redlném case pro dosazeni nejlepsiho
zdzitku ze sledovani monitoru.

E Jak to funguje?

Smartlmage Lite exkluzivni $pickovd technologie
spole¢nosti Philips, kterd analyzuje obsah
zobrazeny na obrazovce. Na zdkladé vami
zvoleného scéndre technologie Smartimage

Lite dynamicky zlepSuje kontrast, sytost barev

a ostrost obrazu pro vylepseni zobrazovaného
obsahu — ve v redlném case stisknutim jediného
tlacitka.

B Jak aktivovat Smartlmage Lite?

1. Stisknutim D se Smartimage Lite zobrazf
na obrazovce;

2. Opakovanym stisknutim B) miZete prepinat
mezi rezimy Standard (Standardnf), Internet,
Game (Hra).

3. Zobrazeni Smartlmage Lite zdstane na
obrazovce po dobu 5 sekund nebo mUzete
rovnéz potvrdit stisknutim tlacitka OK.

4. Po aktivaci technologie Smartimage Lite je

automaticky deaktivovano schéma sRGB.
Aby bylo mozné pouzit schéma sRGB, je
treba deaktivovat funkci Smartimage Lite
stisknutim tlacftka Bf) na prednim panelu
monitoru.
Kromé tlacitka B pro posun doll mizete
rovnéz provést vybér stisknutim tlacitek w A ,
potvrdit vybér stisknutim tlacitka OK a ukondit
nabidku Smartlmage Lite OSD.
Lze vybrat néktery ze Sesti rezimd: Standard
(Standardni), Internet, Game (Hra).

»  Standard (Standardni): Vylepsuje text a
snizuje jas pro zvysenf Citelnosti a omezeni
namahani zraku. Tento rezim podstatné
zvysuje Citelnost a produktivitu pri prdci
s tabulkami, soubory PDF, skenovanymi
¢lanky nebo jinymi obecnymi kanceldrskymi
aplikacemi.

*  Internet: Tento profil kombinuje vylepsenf
sytosti barev, dynamického kontrastu a
ostrosti pro zobrazenf fotografif a dalsich
obrdzkd s vynikajici Cistotou v Zivych
barvich — to vie bez artefaktl a vybledlych
barev.

*  Game (Hra): Tento profil prinasi nejlepsf
hemf z&Zitek pro hrdce, protoze aktivuje
prebuzeny okruh pro optimalni dobu
odezvy, omezen( zubatych okrajd rychle
se pohybujicich objektd na obrazovce a
vylepsenf kontrastniho poméru pro jasné a
tmavé scény.



3.2 SmartContrast

E Cojeto?

Jedine¢nd technologie, kterd dynamicky analyzuje
zobrazeny obsah a automaticky optimalizuje
kontrastni pomér monitoru LCD pro maximdinf
vizudlnf Cistotu a pozitek ze sledovéni. Zvysuje
podsviceni pro jasnéjsi, ostrejsi a jasn&jsi obraz
nebo snizuje podsviceni pro jasné zobrazenf
obrazu s tmavym pozadim.

Bl Prog to potfebuii?

Zéadate nejvy3 vizudlni gistotu a pohodli
sledovén( jakéhokoli typu obsahu. SmartContrast
dynamicky r{df kontrast a upravuje podsvicenf
pro jasné, ostré a jasné zobrazenf her a videa
nebo pro zobrazenf jasného, Citelného textu
pro kanceldrskou praci. Omezenim spotreby
monitoru Setrfte ndklady a prodluzujete Zivot
vaseho monitoru.

E Jak to funguje?

Po aktivaci bude funkce SmartContrast v
redlném case analyzovat zobrazeny obsah a
upravovat barvy a ridit intenzitu podsvicenf. Tato
funkce bude dynamicky vylepSovat kontrast pro
skvély zazitek pri prohlizenf fotografif nebo hrani
her.

3.3 Philips SmartControl Lite

Novy software SmartControl Lite od
spole¢nosti Phillips umozriuje ovlddat monitor
prostrednictvim snadno pouzitelného grafického
rozhrani na obrazovce. Slozitd nastavenf jsou
minulosti, protoZe tento uzivatelsky prijemny
software vds provede jemnym vyladénim
rozlideni, kalibraci barev, nastavenim frekvence/
fdze, nastavenim bilého bodu RGB atd.

Tento software zalozeny na pritazlivych
animovanych ikondch kompatibilni se systémem
Windows 7, ktery je vybaven nejnovejsi
technologif v jddrovém algoritmu pro rychlé
zpracovan( a odezvu, je pripraven rozsitit vasi
zkudenost s monitory Philips!

11

El Instalace

* Postupujte podle pokynt a dokoncete
instalaci.

*  MdZete spustit po dokoncenf instalace.

*  Chcete-li spustit pozdéji, mlzete klepnout
na zdstupce na pracovni plose nebo na
panel nastroju.

Prvni spusténi —Wizard (Privodce)

*  Pfi prvnim spusténi po instalaci prejde
SmartControl Lite automaticky na Wizard
(Privodce).

* Tento prlvodce vds provede podrobnym
nastavenim vykonu monitoru.

*  Prlvodce mlzete rovnéz spustit pozdéji z
nabidky Plug-in (Zdsuvny modul).

*  Dalsi moznosti mlzete nastavit bez
privodce prostrednictvim podokna Standard

(Standardni).



EJ Spusténi s podoknem Standard

(Standardni):

Nabidka Adjust (Nastaveni):

Nabidka Adjust (Nastaveni) umozriuje
upravit Brightness (Jas), kontrast (Kontrast),
Focus (Ohnisko), Position (Poloha) a
Resolution (Rozlisent).

MdZete postupovat podle pokyni a provést
nastaven.

Cancel (Storno) vyzivéd uzivatele, chcete-li
ukoncit instalaci.

12



Nabidka Color (Barva):

Nabidka Color (Barva) umoZnuje upravit
RGB, Black Level (Urove ¢erné), White
Point (Bily bod), Color Calibration (Kalibrace
barev) a Smartlmage Lite (viz ¢ast
Smartlmage Lite).

MUlzete postupovat podle pokynt a provést
nastaven.

V ndsledujici tabulce vyhledejte polozku
podnabidky na zékladé vaseho vstupu.
Priklad pro Color Calibration (Kalibrace

barev)
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Tlacitko ,,Show Me" (Predvést) spustf
vyukovy program pro kalibraci barev.

Start (Spustit) — zahdji sekvenci kalibrace
barev o 6. krocich.

Quick View (Rychlé zobrazenf) nacte
zobrazeni pred/po.

Chcete-li se vratit na hlavni stranku Color
(Barva), klepnéte na tlacitko Cancel
(Storno).

Enable color calibration (Povolit kalibraci
barev) — ve vychoz( konfiguraci je zapnuto.
Pokud tato polozka nenf zaskrtnuta, kalibraci
barev nelze provést a tlacftka rychlé
zobrazeni nejsou k dispozici.

Na kalibracni obrazovce musf byt zobrazeny
informace o patentech.



Calibration Screen (Obrazovka kalibrace)
prvni barvy:

nepodporovaném zobrazovacim zafizenf s
podporou DDC/Cl jsou k dispozici pouze karty
Help (Ndpoveéda) a Options (Moznosti).

» Tlacitko Previous (Predchozi) je
deaktivovdno az na obrazovku druhé barvy.

» Tlacitko Next (Dalsi) slouzi k prechodu na
nasledujici cfl (6 cild).

»  Tlacitko Konecny slouzi k prechodu na File
>Presets (Soubor>podokno Predvolby).

»  Tlacitko Cancel (Storno) slouzi k ukoncent
uzivatelského rozhranf a k ndvratu na
stranku zdsuvnych moduld plug-in.

Smartlmage Lite

Smartlmage — umozruje uzivateli zménit
nastaven( pro vylepseni zobrazeni na zékladé
obsahu.

Kdyz je nastavena moznost Entertainment
(Zéabava), jsou polozky SmartContrast a

SmartResponse k dispozici.

Options>Preferences (Moznosti>Predvolby)
— Tato moznost bude aktivni pouze po
vybéru polozky Preferences (Predvolby) v
rozeviraci nabidce Options (Moznosti). Na

14

Zobrazi nastaven( aktudlnich predvoleb.
Zaskrtnuté tlacitko aktivuje funkci.
Zaskrtavaci policko je prepinac.

Polozka Enable Context Menu (Povolit mistni
nabidku) na pracovni plose je ve vychozf
konfiguraci zaskrtnutd (Zapnuto). Po aktivaci
polozky Enable Context Menu (Povolit mistni
nabidku) se zobrazi vybéry SmartControl
Premium pro funkce Select Preset (Vybrat
predvolbu) a Tune Display (Ladénf
zobrazeni) na pracovni plo3e klepnutim
pravym tlacitkem mysi na mistni nabidku.
Volbou moZnosti Disabled (Deaktivovéno)
bude polozka SmartControl Premium
odstranéna z mistnf nabidky pravym tlacitkem
mysi.

Polozka Enable Task Tray (Povolit ikonu na
hlavnim panelu) je ve vychozi konfiguraci
zaskrtnutd (Zapnuto). Po aktivaci polozky
Enable Context Menu (Povolit mistnf
nabidku) se zobrazi nabidka SmartControl
Lite na hlavnim panelu. Klepnutim pravym
tlacitkem mysi na ikonu na hlavnim panelu se
zobrazf moznosti nabidky Help (Ndpovéda),
Technical Support (Odborna pomoc),
Check for Update (Vyhledat aktualizace),
About (O aplikaci) a Exit (Konec). Kdyz

je deaktivovdna poloZka Enable task tray
menu (Povolit nabidku na hlavnim panelu),
ikona na hlavnim panelu zobrazuje pouze
moznost EXIT (KONEC).



* PoloZka Run at Startup (Spustit pri startu) je
ve vychozf konfiguraci zaskrtnutd (Zapnuto).
Kdyz je tato polozka deaktivovana, funkce
SmartControl Lite se nespustf pri startu
nebo nebude na hlavnim panelu. Funkci
SmartControl Lite Ize spustit pouze
prostrednictvim zdstupce na pracovni
plode nebo prostrednictvim souboru
programu. Kdyz toto policko nenf zaskrtnuté
(Deaktivovdno), zddnd predvolba nastavend
pro spustén( pri startu nebude nactena.

* Enable transparency mode (Aktivovat rezim
prahlednosti) (Windows 7, Vista, XP).
Vychozi nastaveni je 0 % neprdhlednost.

Options>Input (Moznosti>Vstup) — Tato
moznost bude aktivn pouze po vybéru
polozky Input (Vstup) v rozeviraci nabidce
Options (MoZznosti). Na nepodporovaném
zobrazovacim zarizeni' s podporou DDC/CI
jsou k dispozici pouze karty Help (Ndpovéda)
a Options (Moznosti). Zadné dal3f karty funkce
SmartControl Lite nejsou k dispozici.

*  Zobrazi podokno s pokyny Source (Zdroj)
a nastaven( aktudlniho zdroje vstupu.

* U zobrazovacich zarizenf s jednim vstupem
neni toto podokno zobrazeno.

Options>Audio (Moznosti>Zvuk) —Tato

moznost bude aktivni pouze po vybéru polozky

Audio (Hlasitost) v rozeviraci nabidce Options

(Moznosti).

Na nepodporovaném zobrazovacim zafizenf s

podporou DDC/Cl jsou k dispozici pouze karty

Help (Ndpovéda) a Options (Moznosti).
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Help>User Manual (Napovéda>Uzivatelska
prirucka) —Tato moznost bude aktivni pouze
po vybéru polozky User Manual (Uzivatelskd
prirucka) v rozeviraci nabidce Help (Ndpovéda).
Na nepodporovaném zobrazovacim zafizeni s
podporou DDC/Cl jsou k dispozici pouze karty
Help (Ndpovéda) a Options (Moznosti).

Help>Version (Napovéda>Verze) —Tato
moznost bude aktivni pouze po vybéru

polozky Version (Verze) v rozeviraci nabidce
Help (Ndpovéda). Na nepodporovaném
zobrazovacim zarizeni s podporou DDC/CI
jsou k dispozici pouze karty Help (Ndpovéda) a
Options (Moznosti).



Context Sensitive menu (Mistni nabidka)

Context Sensitive Menu (Mistni nabidka) je ve
vychoz( konfiguraci Aktivovdna. Nabidka bude
zobrazena po zaskrtnutf polozky Enable Context
Menu (Povolit mistni nabidku) v ¢asti Options
>podokno Preferences (Moznosti>podokno

Predvolby).

Context Menu (Mistni nabidka) obsahuje ctyri

polozky:

*  SmartControl Lite - po vybéru se zobrazf
obrazovka About (O) aplikaci.

* Select Preset (Vybrat predvolbu) — nabizf
hierarchickou nabidku ulozenych predvoleb
pro okamzité pouzitl. Aktudiné vybrand
predvolba je oznacena zaskrtnutim. V
rozeviraci nabidce Ize rovnéz vybrat polozku
Factory Preset (Predvolby vyrobce).

* Tune Display (Ladéni zobrazeni) — otevre
ovlddaci panel SmartControl Lite.

*  Smartlmage Lite — zkontrolujte aktudlnf
nastaveni Standard (Standardni), Internet,
Game (Hra).

Aktivovana nabidka hlavniho panelu

Nabidku hlavniho panelu Ize zobrazit klepnutim
pravym tlacitkem mysi na ikonu SmartControl
Lite na hlavnim panelu. Klepnutim levym
tlacitkem Ize spustit aplikaci.
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Help

Technical Support
Check for Update
About

Exik

Hlavni panel obsahuje pét polozek:

*  Help (Ndpovéda) — pristup k souboru
s User Manual (uZivatelskou priruckou):
Otevr'e soubor s User Manual (uzivatelskou
priruckou) v okné vychoziho prohlizece.

* Technical Support (Odbornd pomoc) —
zobrazi stranku odborné pomoci.

*  Check for Update (Vyhledat aktualizace) —
zobrazf Uvodn( strdnku PDI a porovnd verzi
uzivatele s nejaktudlnéjsi dostupnou verzi.

*  About (O aplikaci) — zobrazi podrobné
referencni informace: verze produktu,
informace o vydanf a nazev produktu.

*  Exit (Konec) — ukon¢i SmartControl Lite

Chcete-li znovu spustit funkci SmartControl Lite,

vyberte polozku SmartControl Lite z nabidky

Program, poklepejte na ikonu na pracovn{ plose

pocitace nebo restartujte pocital.

PHILIPS

Deaktivovana nabidka Task Tray (hlavniho
panelu)

Kdyz je hlavni panel deaktivovan ve slozce
predvolby, je k dispozici pouze ¢ast EXIT
(KONECQ). Chcete-li funkci SmartControl
Lite zcela odstranit z hlavniho paneluy,
deaktivujte polozku Run at Startup (Spustit
pri startu) v &asti Options>Preferences
(Moznosti>Predvolby).



4. PowerSensor™

(K dispozici pouze pro model 247E3LPH)

PowerSensor je jedinecnd ekologickd technologie od spolec¢nosti Philips, kterd umozniuje usetrit az 80 %
spotreby energie. Spolecné s citem a jednoduchosti Philips tato uzivatelsky prijemnd technologie funguje
ihned po vybalenf bez nutnosti instalace hardwaru nebo softwaru a bez jakéhokoli zdsahu uzivatele ve
vychozim rezimu.

a Jak to funguje?

» PowerSensor funguje na principu vysilani a prijiman{ neskodnych , infratervenych® signdlti za tcelem
rozpozndvan( prftomnosti uZivatele.

*  Kdyz se uzivatel nachdzf pred monitorem, monitor funguje normdlné podle nastaveni, kterd uzivatel
predem proved| — tzn. jas, kontrast, barva atd.

* Napriklad jestlize byl monitor nastaven na 100% jas, v okamziku, kdy uZzivatel opustf své misto a
nenachdzf se prfed monitorem, monitor automaticky omezi spotrebu az o 80%.

Uzivatel pred monitorem Zadny uzivatel ped monitorem

20 20
0 w0 0 0

/ \

(g

S (s

Prikon uvedeny vyse je pouze informativni

Bl Nastaveni

Vychozi nastaveni

Ve vychozim nastaveni (Nastaven( 3) technologie PowerSensor rozpoznava prftomnost uzivatele
monitoru, ktery se nachdzi mezi 90 a 110 cm (35,4 a 43,3 palci) od monitoru a v Uhlu pét stuprid
nalevo a napravo od monitoru.

Vlastni nastaveni

»  Kdyz uzivatel zvoli polohu mimo vySe uvedené perimetry, zvolte vy33i silu signdlu pro optimalnf
Ucinnost rozpozndvani: S vyssim nastavenim se zesiluje signdl rozpozndvani. Pro dosazeni” maximalnf{
Ucinnosti technologie PowerSensor a spravné detekce sedte primo pred monitorem.

* Pokud se rozhodnete posadit ddle nez 110 cm nebo 43,3 palci od monitoru, pouzifte maximalni
signdl rozpozndvani pro vzdalenosti do 130 cm nebo 51,2 palch. (Nastaven( 4)
*  Vzhledem k tomu, Ze md barevné obleceni tendenci absorbovat infracervené signdly i kdyz se

uzivatel nachdzi do vzdalenosti 100 cm nebo 40 palcl od monitoru, zvyste silu signdlu, pokud mate
na sobé cerné nebo tmavé oblecent.
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*  Kdykoli se mlZete vrétit do vychoziho reZimu (Nastaveni 3).

Rychlé tladitko Vzdalenost snimace

= nnnnnn +3

/v Ofa SENSOR/ 4 /oK »

El Pokyny pro zmény nastaveni

Pokud technologie PowerSensor nefunguje spravné uvniti nebo vné vychoziho rozsahu, jemné
vyladte rozpoznavani podle ndsledujicich pokynu:

»  Stisknéte kldvesovou zkratku PowerSensor:

* Najdete vychozi polohu ‘3" na panelu nastaven.

* Upravte nastaveni rozpozndvani technologie PowerSensor na Nastaveni 4 a stisknéte OK.

*  Vyzkousejte novou konfiguraci a presvédcte se, zda vés technologie PowerSensor rrddné
rozpozndvd ve vasi aktudini poloze.

& Poznimka

Rucné vybrany rezim PowerSensor zUstane funkéni, dokud jej nezménite nebo dokud neobnovite
vychozi rezim. Pokud je technologie PowerSensor prilis citlivd na okolni pohyb, vyzkousejte mensi silu
signdlu.
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5. Technickeé udaje

Typ panelu LCD TFT-LCD

Podsvicenf LED

Velikost panelu 23,6" W (59,9 cm)

Pomér stran 169

Rozte¢ obrazovych bodu 0,2715 x 0,2715 mm

Jas 250 cd/m?

SmartContrast 20.000.000:1

Kontrastni pomér (typ.) 1000:1

Doba odezvy (typ.) 5ms

SmartResponse 2ms (k dispozici pro model 247E3LH, 247E3LPH)

Optimalni rozlisent

1920x1080 pri 60Hz

170° (H) / 160° (V) pfi C/R > 10

Vstup signdlu

g7 178° (H) / 170° (V) pii C/R > 5
Vylepseni obrazu Smartimage Lite

Barevnost displeje 16,/M

Vertikdni obnovovaci frekvence | 56Hz - 76Hz

HorizontdIni frekvence 30kHz - 83kHz

sRGB ANO

DVI (digitdlni), VGA (analogovy)
HDMI (k dispozici pro model 247E3LH, 247E3LPH)

Vstupni signdl

Usnadnéni pro uzivatele

Oddélend synchronizace, synchronizace podle zelené

247E3L: /v /A /< /0K 0)
247E3L(1A): ®/v TN /4 o/ 10)
247E31LH: ED/v ®/A (/< B/0K 0}
247E3LPH:  ED/V¥ ©/A SENSOR/ < /0K 0}

Jazyky nabidky OSD

anglictina, francouzstina, némcina, Spanélstina, italstina, rustina,
zjednodusena ¢instina, portugalstina, turectina

Dalsi usnadnénf

Zamek Kensington

Kompatibilita s technologif
Plug & Play

Naklon

DDC/CI, sRGB, Windows 7/Vista/XP, Mac OSX, Linux

-5/+20

247E3L:

Zapnuto (typ.)

20,85W(typ.)

Spotreba energie
(Metoda testovan( EnergyStar
5.0)

Stridavé vstupni
napéti pri T00VAC
+/-5VAC, 50Hz +/-
3Hz

Stridavé vstupni
napéti pri T15VAC
+/-5VAC, 60Hz +/-
3Hz

Stridavé vstupni
napéti pri 230VAC
+/-5VAC, 50Hz +/-
3Hz

Normalni provoz (typ.)

16,86W

16,75W

16,6W
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Spanek

0,5W

0,5W

0,5W

Vypnuto

0,5W

0,5W

0,5W

Rozptyl tepla*

Strfdavé vstupnf
napétf pri T00VAC
+/-5VAC, 50Hz +/-
3Hz

Strfdavé vstupnf
napétf pri 115VAC
+/-5VAC, 60Hz +/-
3Hz

Strfdavé vstupnf
napétf pri 230VAC
+/-5VAC, 50Hz +/-
3Hz

Bézny provoz

57,54 BTU/hod.

57,17 BTU/hod.

56,66 BTU/hod.

Spanek

1,71 BTU/hod.

1,71 BTU/hod.

1,71 BTU/hod.

Vypnuto

1,71 BTU/hod.

1,71 BTU/hod.

1,71 BTU/hod.

Indikdtor LED napajent

Zapnuto: Bild, Pohotovostni rezim/rezim spanku: Bild (blika)

Napdjenf

Integrovany, 100-240VAC, 50/60Hz

247E3LH:

Zapnuto (typ.)

20,85W(typ.), 26W(max.)

Spotreba energie
(Metoda testovani EnergyStar
5.0)

Stridavé vstupnf
napéti pri T00VAC
+/-5VAC, 50Hz +/-
3Hz

Stridavé vstupni
napéti pri 115VAC
+/-5VAC, 60Hz
+/-3Hz

Stridavé vstupnf
napéti pri 230VAC
+/-5VAC, 50Hz +/-
3Hz

Normalni provoz (typ.) 17,32W 17,55W 17,53W
Spének 0,5W 0,5W 0,5W
Vypnuto 0,3W 0,3W 0,3W

Rozptyl tepla*

Stridavé vstupni
napétf pri T00VAC
+/-5VAC, 50Hz +/-
3Hz

Stridavé vstupni
napétf pri 115VAC
+/-5VAC, 60Hz
+/-3Hz

Stridavé vstupni
napétf pri 230VAC
+/-5VAC, 50Hz +/-
3Hz

BéZny provoz

59,11 BTU/hod.

59,9 BTU/hod.

59,83 BTU/hod.

Spanek

1,71 BTU/hod.

1,71 BTU/hod.

1,71 BTU/hod.

Vypnuto

1,02 BTU/hod.

1,02 BTU/hod.

1,02 BTU/hod.

Indikdtor LED napdjenf

Zapnuto: Bild, Pohotovostni rezim/rezim spanku: Bild (blika)

Napdjenf

Integrovany, 100-240 VAC, 50/60Hz

247E3LPH:

Zapnuto (typ.)

20,85W(typ.), 23W/(max.)

Spotreba energie
(Metoda testovani EnergyStar
5.0)

Stridavé vstupnf
napéti pri T00VAC
+/-5VAC, 50Hz +/-
3Hz

Stridavé vstupnf
napéti pri 115VAC
+/-5VAC, 60Hz +/-
3Hz

Stridavé vstupnf
napéti pri 230VAC
+/-5VAC, 50Hz +/-
3Hz

Normalni provoz (typ.) 17,14W 17,04W 17,02W
Spanek 0,5W 0,5W 0,5W
Vypnuto 0,3W 0,3W 0,3W

Rozptyl tepla*

Stridavé vstupnf
napéti pri T00VAC
+/-5VAC, 50Hz +/-
3Hz

Stridavé vstupni
napéti pri 115VAC
+/-5VAC, 60Hz +/-
3Hz

Stridavé vstupni
napéti pri 230VAC
+/-5VAC, 50Hz +/-
3Hz

Bézny provoz

58,5 BTU/hod.

58,16 BTU/hod.

58,09 BTU/hod.
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Spanek 1,71 BTU/hod. 1,71 BTU/hod. 1,71 BTU/hod.
Vypnuto 1,02 BTU/hod. 1,02 BTU/hod. 1,02 BTU/hod.
Indikdtor LED napdjenf Zapnuto: Bil4, Pohotovostn( rezim/rezim spdnku: Bild (blikd)
Napdjen( Integrovany, 100-240VAC, 50/60Hz

Vyrobek s podstavee (SxVxH)
Vyrobek bez podstavce (SxVxH)

5794 x 442,4 x 238 mm
5794 x 362,7 x 41,1 mm

Vyrobek s podstavcem 4,5 kg
Vyrobek bez podstavce 3,97 kg
Vyrobek s obalem 6,33 kg
Teplotni rozsah (provoz) 0°C az 40 °C
Teplotni rozsah (mimo provoz) | -20°C az 60°C
Relativni vihkost 20% az 80%

LR o Pouzirdni: + 12.000 stop (3.658 m)
Nadmorsid vyska Mimo provoz: + 40.000 stop (12192 m)
MTBF 30.000 hod.

ROHS ANO
EPEAT Silver (www.epeat.net)
Balenf 100% recyklovatelny

CE Mark, FCC Class B, GOST, SEMKO, TCO Certified, UL/cUL,

Prohlaseni o shodé BSMI, 1SO9241-307

Barva Cerny (vzadu), Cemy/Cemomodry odstin (vpiedu)
Povrchova dprava Leskd
© Poznamka

1. Certifikdt EPEAT Gold nebo Silver je platny pouze tam, kde spolec¢nost Philips zaregistruje produkt.
Informace o stavu registrace ve vasi zemi viz www.epeat.net.

2. Tyto Udaje se mohou zménit bez predchoziho ozndment. Stéhnéte si nejnovéjsi verzi letdku z webu
www.philips.com/support.
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5.1 Rezimy rozliSeni a pfedvoleb

H Maximélni rozli$eni
1920x1080 pri 60Hz (analogovy vstup)
1920x1080 pri 60Hz (digitalni vstup)

Bl Doporuéené rozliseni
1920x1080 pri 60Hz (digitalni vstup)

31,47 720x400 70,09
31,47 640x480 59,94
35,00 640x480 66,67
37,86 640x480 72,81
37,50 640x480 75,00
37,88 800x600 60,32
46,88 800x600 75,00
48,36 1024x768 60,00
60,02 1024x768 75,03
63,89 1280x1024 60,02
79,98 1280x1024 75,03
55,94 1440x900 59,89
70,64 1440x900 74,98
65,29 1680x1050 59,95
67,50 1920x1080 60,00
& Poznimka

Upozorfiujeme vds, Ze tento monitor funguje
nejlépe pri nativnim rozliseni 1920X1080 pr
60Hz. Pro dosaZen( optimdin( kvality zobrazenf
dodrzujte toto doporucené rozlisen.
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6. Rizeni spotieby

Pokud je v daném pocitaci nainstalovan software
nebo videokarta vyhovujici normé DPM
organizace VESA, monitor dokdze automaticky
snizit svou spotrebu energie, neni-li pouzivan.
Pokud pocfta¢ rozpoznad vstup z kldvesnice,

my3i nebo jiného vstupniho zafizenf, monitor se
automaticky ,,probudf*. Ndsledujic tabulka uvadf
spotrebu energie a signalizaci této funkce pro
automatickou Usporu energie:

247E3L:
Rezim |, ,. Spotreba Barva
s, ||| IRksmen | Vesmein| “Cooe” |ineiiiiena 15D
Aktivn{ | ZAP. | Ano Ano [ 20,85W(typ.) Bild
Spének | VYP. Ne Ne 0,5 W (typ.) Bfld (blikd)
Vypnuto | VYP. - - 05 W (typ.) VYP.
247E3LH:
Rezim |, Spotieba Barva
s || Vs |irksmen | [Veagmei | ot e LED
20,85W(typ.),
Aktivni | ZAP. [ Ano Ano &P Bila
26W(max.)
Spanek | VYP. Ne Ne 05 W (typ.) Bl (blikd)
Vypnuto | VYP. - - 03 W (typ.) VYP.
247E3LPH:
Rezim |, Spotieba Barva
Vs || Vs |imksmen | [Veamme | Cire” ||ineiietie LED)
20,85W(typ.),
Aktivn{ | ZAP. [ Ano Ano ®p) Bild
23W(max.)
Spanek | VYP. Ne Ne 05 W (typ.) Bl (blikd)
Vypnuto | VYP. - - 03 W (typ.) VYP.

23

Nasledujici konfigurace se pouzivd pri mérenf
energetické spotreby tohoto monitoru.

* Nativni rozliseni: 1920x1080

*  Kontrast: 50%

e Jas: 300 nitC

*  CBarevna teplota: 6500K s pIné bilym

vzorkem

& Poznimka
Tyto Udaje se mohou zménit bez predchoziho

oznamenit.



7. Informace o regulaci

Lead-free Product

Lead free display promotes
environmentally sound recovery
and disposal of waste from electrical
and electronic equipment. Toxic
substances like Lead has been eliminated

and compliance with European community’s
stringent RoHs directive mandating restrictions
on hazardous substances in electrical and
electronic equipment have been adhered to

in order to make Philips monitors safe to use
throughout its life cycle.

Congratulations!

This display is designed for both you and the
planet

The display you have just purchased

carries the TCO Certified label.

This ensures that your display is
designed, manufactured and tested according to
some of the strictest quality and environmental
requirements in the world. This makes for a
high performance product, designed with the
user in focus that also minimizes the impact on
the climate and our natural environment.

TCO Certified is a third party verified program,
where every product model is tested by an
accredited impartial test laboratory. TCO
Certified represents one of the toughest
certifications for displays worldwide.

Some of the Usability features of the TCO
Certified for displays:

* Visual ergonomics for good image quality
is tested to ensure top performance and
reduce sight and strain problems. Important
parameters are luminance, contrast,
resolution, black level, gamma curve, colour
and luminance uniformity and colour
rendering.

*  Products are tested according to rigorous
safety standards at impartial laboratories.

* Electric and magnetic fields emissions as
low as normal household background
levels.

* Low acoustic noise emissions (when
applicable).

Some of the Environmental features of the
TCO Certified for displays:

* The brand owner demonstrates corporate
social responsibility and has a certified
environmental management system (EMAS
or ISO 14001).

*  Very low energy consumption both in on-
and standby mode minimize climate impact.

* Restrictions on chlorinated and brominated
flame retardants, plasticizers, plastics and
heavy metals such as cadmium, mercury
and lead (RoHS compliance).

* Both product and product packaging is
prepared for recycling.

* The brand owner offers take-back options.

The requirements can be downloaded from our
web site. The requirements included in this label
have been developed by TCO Development

in co-operation with scientists, experts, users as
well as manufacturers all over the world. Since
the end of the 1980s TCO has been involved

in influencing the development of IT equipment
in a more user-friendly direction. Our labeling
system started with displays in 1992 and is

now requested by users and [T-manufacturers
all over the world. About 50% of all displays
worldwide are TCO certified.

For more information, please visit:
www.tcodevelopment.com

TCOF1058 TCO Document,Ver. 2.1

I[n Technology for you and the planet
CERTIFIED


www.tcodevelopment.com

EPEAT
(www.epeat.net)
> The EPEAT (Electronic
QQ Product Environmental
<

Assessment Tool) program
evaluates computer
desktops, laptops, and monitors based on

51 environmental criteria developed through
an extensive stakeholder consensus process
supported by US EPA.

EPEAT system helps purchasers in the public
and private sectors evaluate, compare and
select desktop computers, notebooks and
monitors based on their environmental
attributes. EPEAT also provides a clear and
consistent set of performance criteria for the
design of products, and provides an opportunity
for manufacturers to secure market recognition
for efforts to reduce the environmental impact
of its products.

Benefits of EPEAT

Reduce use of primary materials
Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT'S
requirement that all registered products meet
ENERGY STAR'’s energy efficiency specifications,
means that these products will consume less
energy throughout their life.

25

CE Declaration of Conformity

This product is in conformity with the following
standards

* EN60950-1:2006 (Safety requirement of
Information Technology Equipment).

»  EN55022:2006 (Radio Disturbance
requirement of Information Technology
Equipment).

*  EN55024:1998+A1:2001+A2:2003
(Immunity requirement of Information
Technology Equipment).

* EN61000-3-2:2006 (Limits for Harmonic
Current Emission).

+  EN61000-3-3:1995+A1:2001+A2:2005
(Limitation of Voltage Fluctuation and
Flicker) following provisions of directives
applicable.

*  2006/95/EC (Low Voltage Directive).

*  2004/108/EC (EMC Directive).

» 2005/32/EC (EuP Directive, EC No.
1275/2008 mplementing Directive
for Standby and Off mode power
consumption) and is produced by a
manufacturing organization on 1SO9000
level.

The product also comply with the following

standards

*  1SO9241-307:2008 (Ergonomic
requirement, Analysis and compliance test
methods for electronic visual displays).

e GS EK1-2000:2009 (GS mark requirement).

*  prEN50279:1998 (Low Frequency Electric
and Magnetic fields for Visual Display).

e MPR-II (MPR:1990:8/1990:10 Low
Frequency Electric and Magnetic fields).

*  TCO CERTIFIED (Requirement for
Environment Labeling of Ergonomics,
Energy, Ecology and Emission, TCO: Swedish
Confederation of Professional Employees)
for TCO versions.



Energy Star Declaration

(www.energystar.gov)

As an ENERGY STAR® Partner, we
have determined that this product

meets the ENERGY STAR®
guidelines for energy efficiency.

i)

& Note

We recommend you switch off the monitor
when it is not in use for a long time.

Federal Communications Commission (FCC)
Notice (U.S. Only)

€& This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation.
This equipment generates, uses and can
radiate radio frequency energy and, if not
installed and used in accordance with the
instructions, may cause harmful interference
to radio communications.

However, there is no guarantee that
interference will not occur in a particular
installation. If this equipment does cause
harmful interference to radio or television
reception, which can be determined by
turning the equipment off and on, the
user is encouraged to try to correct

the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

»  Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

»  Consult the dealer or an experienced
radio/TV technician for help.
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@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority
to operate the equipment.

Use only RF shielded cable that was supplied
with the monitor when connecting this monitor
to a computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

FC

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following
two conditions: (1) this device may not cause
harmful interference, and (2) this device must
accept any interference received, including
interference that may cause undesired
operation.

Commission Federale de la Communication
(FCC Declaration)

& Cet équipement a été testé et déclaré
conforme auxlimites des appareils
numériques de class B,aux termes de l'article
15 Des regles de la FCC. Ces limites sont
congues de facon a fourir une protection
raisonnable contre les interférences nuisibles
dans le cadre d'une installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est
pas installé et utilisé selon les consignes
données, peuvent causer des interférences
nuisibles aux communications radio.


www.energystar.gov

Cependant, rien ne peut garantir |'absence
d'interférences dans le cadre d'une
installation particuliere. Si cet appareil est
la cause d'interférences nuisibles pour

la réception des signaux de radio ou de
télévision, ce qui peut étre décelé en
fermant I'équipement, puis en le remettant
en fonction, |'utilisateur pourrait essayer de
corriger la situation en prenant les mesures
suivantes:

* Réorienter ou déplacer I'antenne de
réception.

* Augmenter la distance entre I'équipement
et le récepteur.

*  Brancher I'équipement sur un autre circuit
que celui utilisé par le récepteur

¢ Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

@ Toutes modifications n'ayant pas recu
I'approbation des services compétents
en matiére de conformité est susceptible
d'interdire a l'utilisateur I'usage du présent
équipement.

N'utiliser que des cables RF armés pour
les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTE TOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.
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EN 55022 Compliance (Czech Republic Only)

Polish Center for Testing and Certification
Notice

The equipment should draw power from a
socket with an attached protection circuit (a
three-prong socket). All equipment that works
together (computer, monitor, printer, and so
on) should have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/
T-42107 and PN-89/E-06251.



North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR
DU STALLER DIN UTRUSTNING PAPLATS,

Placering/Ventilation

ADVARSEL:

SORG VED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT
ER NEMT TILG/ANGELIGE.

Paikka/llmankierto

VAROITUS:

SIJOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR

ST@MTILF@RSEL ER LETTE A NA.

BSMI Notice (Taiwan Only)
RBAZEARERZIBE |

Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht
den in der "Verordnung Uber den Schutz vor
Schiden durch Réntgenstrahlen" festgelegten
Vorschriften.

Auf der Rickwand des Gerites befindet sich
ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften
Uber die Bauart von Stérstrahlern nach Anlage
a5 Abs. 4 der Réntgenverordnung erfilit
sind.

Damit Ihr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, dal3

1. Reparaturen nur durch Fachpersonal
durchgefiihrt werden.
2. nur original-Ersatzteile verwendet werden.

bei Ersatz der Bildréhre nur eine
bauartgleiche eingebaut wird.

Aus ergonomischen Griinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf
dunklem Untergrund zu verwenden (schlechte
Lesbarkeit und erhéhte Augenbelastung bei zu
geringem Zeichenkontrast waren die Folge).
Der arbeitsplatzbezogene Schalldruckpegel
nach DIN 45 635 betrdgt 70dB (A) oder
weniger.

) ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAR NETZSTECKER UND
NETZKABELANSCHLUB LEICHT
ZUGANGLICH SIND.



China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products including CRT and Monitor
which are produced and sold for China market
have to meet China RoHS request.
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8. Péce o zakazniky a zaruka

8.1 Postup pri vadnych pixelech
plochého panelu spolecnosti
Philips

Spolecnost Philips se snazi doddvat vyrobky
vyrobnich postup( vyroby v tomto odvétvi a
prosazuje prisnou kontrolu kvality. Defektim
obrazovych bodd nebo dil¢ich obrazovych
bodl u panelt TFT LCD, které se pouzivajf
pro ploché monitory, se nicméné nékdy nedd
zabranit. Zadny vyrobce nemuize zarudit, ze
vsechny panely budou bez defektd obrazovych
bodd, ale spole¢nost Philips zarucuje, ze kazdy
monitor s nepfijatelnym poctem defektl bude
v rdmci zdruky opraven nebo vymeénén. Tento
text vysvétluje jednotlivé druhy defektd na
pixelech a urcuje Unosnou urover chybovosti
pro kazdy druh. Aby bylo mozné uplatnit zarucnf
opravu nebo vyménu, musi pocet defektnich
obrazovych bodd panelu TFT LCD presdhnout
tuto Uroveri dnosnosti. Na monitoru napriklad
nesmf byt vice defektnich dil¢ich obrazovych
bodd nez 0,0004 %. Déle, protoze nékteré typy
kombinaci vad pixeltl jsou lépe postrehnutelné
nez jiné, stanovuje pro né spolec¢nost Philips
jesté vetsi ndroky na kvalitu. Tato norma se
dodrzuje celosvetove.

subpixely

cB

pixely

Pixely a subpixely

Pixel, neboli obrazovkovy bod, se sklddd ze t#
subpixeld v zdkladnich barvéch cervené, zelené a
modré. Kdyz je mnoho pixeld pohromadg, tvorf
obraz. Kdyz viechny subpixely uréitého pixelu
svitf, jevi se tyto tii subpixely spole¢né jako
jediny bily pixel. Kdyz jsou vechny tmavé, jevl
se tyto ti subpixely jako jeden cerny pixel. Dalsf
kombinace rozsvicenych a tmavych subpixell se
jevi jako pixely rdznych barev.
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Druhy pixelovych vad

Vady pixel(l a subpixeld se na obrazovce
projevuji riznymi zpUsoby. Existuj dva druhy vad
pixelu a v rdmci téchto druhd je nékolik typd
subpixelovych vad.

Defekty svétlych bodu

Defekty svétlych bodl se projevuji jako
obrazové body nebo dil¢i obrazové body, které
vzdy sviti nebo jsou 'aktivni". Svétly bod je dilcf
obrazovy bod, ktery vystupuje z obrazovky, kdyz

je na monitoru zobrazena tmava plocha. Existuj
nasledujici typy defektl svétlych bodu:

Jeden cerveny, zeleny nebo modry subpixel.

1 ¢

Dva soundlezicl subpixely:
- Cerveny + modry = fialovy
- Cerveny + zeleny = Zluty

- zeleny + modry = svétle modry

Tri soundleZici rozsvicené subpixely (jeden bily
pixel).



€& Poznamka

Cerveny nebo modry svétly bod musf byt o
vice nez 50 procent jasnéjsi, nez sousedni body;
zeleny svétly bod je o 30 procent jasnéjsi, nez
sousedni body.

Defekty tmavych bodl

Defekty tmavych bodu se projevuif jako
obrazové body nebo dil¢f obrazové body, které
nikdy nesviti nebo jsou , neaktivni. Tmavy bod je
dil¢i obrazovy bod, ktery vystupuje z obrazovky,
kdyz je na monitoru zobrazena svétld plocha.

Existuji ndsledujicl typy defektd tmavych bodd:

Vzdalenost pixelovych vad

Protoze vady pixell a subpixell stejného

typu, které se vyskytuji blizko sebe, mohou byt
patrnéjsi, urcuje spolecnost Philips i tolerance na
vzdélenost vad pixeld.

Tolerance vad pixelQ

Aby bylo mozné uplatnit opravu nebo vyménu
kvdli defektnim obrazovym bodlm v zaru¢nf
dobé, musi panel TFT LCD plochého monitoru
Philips vykazovat defekty obrazovych bodu
nebo dil¢ich obrazovych bod(, které prekracujf
tolerance uvedené v ndsledujicich tabulkdch.

KAZY JASNYCH BODU

PRIJATELNY POCET VAD

1 trvale svitici bod 3
2 sousedni trvale svitici body 1
3 sousedn/ trvale svitici body (nebo 1 trvale svitici bily bod) 0
Vzddlenost mezi dvéma kazy jasnych bodi* >15mm
Celkovy pocet kazl jasnych bodd viech typl 3

KAZY CERNYCH BODU
1 tmavy bod

PRIJATELNY POCET VAD
5 nebo méné

2 sousedni tmavé body

2 nebo méné

3 sousedni tmavé body

0

Vzdélenost mezi dvéma kazy cernych bodi*

>15mm

Celkovy pocet kaztl ¢ernych bodd viech typl

5 nebo méné

KAZy bodu celkem

Celkovy pocet kazl jasnych nebo c¢emych bodl vech typt

PRIJATELNY POCET VAD
5 nebo méné

€& Poznimka

1. 1 nebo 2 sousedni vadné body (1 barva) = 1 vadny bod
2. Tento monitor je kompatibilni se standardem ISO 9241-307. ( ISO 9241-307: Ergonimicky
pozadavek, analyza a metody testovani shody pro elektronickd zobrazovaci zarizen)




8.2 Péce o zakazniky & zaruka

Podrobné informace o zdruce a poZadavku na dodate¢nou podporu platné pro vasi oblast najdete na
webu www.philips.com/support. Rovnéz mizete kontaktovat mistni centrum péce o zdkazniky na nize
uvedenych telefonnich &islech.

Kontaktni informace pro oblast ZAPADNI EVROPY:

Zemé ASC Cislo zakaznické péce Cena
Germany Siemens &S +49 01803 386 853 €009
United Kingdom Invec Scotland +44 0207 949 0069 Local call tariff
Ireland Invec Scotland +353 01 601 1161 Local call tariff
Spain Eatsa Spain +34 902 888 785 €010
Finland A-novo +358 09 2290 1908 Local call tariff
France A-novo +33 082161 1658 €009
Greece Allman Hellas +30 00800 3122 1223 Free of charge
[taly A-novo +39 840 320 041 €008
Netherlands E Care +31 0900 0400 063 €010
Denmark A-novo +45 3525 8761 Local call tariff
Norway A-novo +47 2270 8250 Local call tariff
Sweden A-novo +46 08 632 0016 Local call tariff
Poland Zolter +48 0223491505 Local call tariff
Austria Siemens &S +43 0810 000206 €007
Belgium E Care +32 078 250851 €006
Luxembourg E Care +352 26 84 30 00 Local call tariff
Portugal Eatsa Spain +351 2 1359 1440 Local call tariff
Switzerland A-novo +41 02 2310 2116 Local call tariff
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Kontaktni informace pro oblast STREDNI A VYCHODNI EVROPY:

Telefonni stredisko ASC Cislo zikaznické péce
Belarus NA IBA +375 17 217 3386
Bulgaria NA LAN Service +359 2 960 2360
Croatia NA Renoprom +385 1 333 0974
Estonia NA FUJITSU +372 6519900
Latvia NA “ServiceNet LV" Ltd. +371 7460399
Lithuania NA UAB "Servicenet" +370 7400088
Romania NA Blue Ridge Intl. +40 21 2101969
woroe fegm NA Kim Tec doo. +381 11 20 70 684
Slovenia NA PC H.and +386 1 530 08 24
NA Comel +380 562320045
Haine NA E‘(’)fna;fn‘;mce +38 044 245 73 31
- NA CPS +7 (495) 645 6746 (for repair)
NA CEEE Partners +7 (495) 645 3010 (for sales)
Slovakia NA Datalan Service +421 2 49207155
Turkey NA Techpro +90 212 444 4 832
Czech Rep. NA Asupport 800 100 697
NA Serware +36 1 2426331
Hungary :
NA Profi Service +36 1 814 8080

Kontaktni informace pro oblast LATINSKE AMERIKY:

Zemé Telefonni stredisko Cislo zakaznické péce

Brazil 0800-7254101
Vermont

Argentina 0800 3330 856

Kontaktni informace pro Cinu:

Cina
Cislo zékaznické péce: 4008 800 008

Kontaktni informace pro SEVERNI AMERIKU:

Telefonni stredisko ASC Cislo zékaznické péce
USA. TOS Teleplan (877) 835-1838
Canada Supercom Supercom (800) 479-6696
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Kontaktni informace pro oblast APMEA:

Telefonni <, 2 A B
stFedisko Cislo zakaznické péce
Australia NA AGOS NETWORK PTY LTD [ 1300 360 386
New Zealand NA Visual Group Ltd. 0800 657447
. Hong Kong:Tel: +852 2619 9639
Hong Kong / Macau | NA Smart Pixels Technology Ltd. Macau:Tel: (853)-0800-987
. Tel: 1 800 425 6396
India NA REDINGTON INDIA LTD SMS: PHILIPS 1o 56477
Ind ) NA PT. Gadingsari elektronika Tel: 62 21 75909053, 75909056,
Aeonesia Prima 7511530
South Korea NA PCS One Korea Ltd. 080-600-6600
: After Market Solutions (CE)
Malaysia NA Sdn Bhd 603 7953 3370
Pakistan NA Philips Consumer Service (9221) 2737411-16
Philips Electronics Singapore
Singapore NA Pte Ltd (Philips Consumer (65) 6882 3999
Care Center)
PCCW
Taiwan Teleservices FETEC.CO 0800-231-099
Taiwan
Thailand NA s Computer System €O+ (46 934-5498
South Africa NA Sylvara Technologies Pty Ltd | 086 0000 888
Unllted Arab NA AL SHAHD COMPUTER 00971 4 2276525
Emirates LLC
Israel NA Eastronics LTD 1-800-567000
: : +84 8 38248007 Ho Chi Minh City
Vietnam NA EZTmsear:'cftg‘format'c +84 5113.562666 Danang City
Py +84 5113562666 Can tho Province
I . (02) 633-4533 to 34,
Philippines NA Glee Electronics, Inc. (02) 637-6559 to 60
Sri Lanka NA no d!strlbutor and/or service
provider currently
Bangladesh NA Distributor: Computer Source | 880-2-9141747, 9127592
g Ltd (warranty buy-out) 880-2-8128848 / 52
Nepal NA Distributor: Syakar Co. Ltd 977-1-4222395
(warranty buy-out)
Distributor: Neat Technology
Cambodia NA Pte Ltd (Singapore) (warranty | 855-023-999992
buy-out)
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9. Odstranovani probléma a
Casté dotazy

9.1 Odstranovani problému

Na této strance jsou uvedeny problémy,
které mize odstranit uzivatel. Pokud problém
pretrvdvd i po vyzkousenf téchto resent,
kontaktujte zdstupce sluzeb pro zdkazniky
spolecnosti Philips.

El Bé&iné problémy

Zadny obraz (indikator LED napajeni nesviti)

»  Zkontrolujte, zda je napdjeci kabel pripojen
k elektrické zdsuvce a do zadni ¢asti
monitoru.

*  Nejdrive zkontrolujte, zda se vypinac na
predni strané monitoru nachazi ve OFF
(VYPNUTE) poloze a stisknéte jej do ON
(ZAPNUTE) polohy.

Zadny obraz (indikator LED napijeni je bily)

»  Zkontrolujte, zda je zapnuty pocitac.

»  Zkontrolujte, zda je kabel signdlu rddné
pripojen k pocitadi.

» Zkontrolujte, zda nejsou ohnuté koliky na
pripojovac( strané kabelu monitoru. Pokud
ano, opravte nebo vymérite kabel.

*  Pravdépodobné je aktivovdna funkce Energy
Saving (Fizenf spotreby)

Obrazovka rika

Attention

Check cable connection

» Zkontrolujte, zda je kabel monitoru rfddné
pripojen k pocitadi. (Rovnéz viz Strucnd
prirucka).

»  Zkontrolujte, zda nejsou ohnuté koliky
kabelu monitoru.

» Zkontrolujte, zda je zapnuty pocital.
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Tlagitko AUTO nefunguje

* Automaticka funkce je pouzitelnd pouze
v rezimu VGA-Analog (VGA-analogovy).
Pokud vysledek nenf uspokojivy, mizete
provést ru¢ni Upravy prostrednictvim
nabidky OSD.

© Pozniamka

Auto (Automatickd) funkce nenf pouzitelna

v rezimu DVI-Digital (DVI-digitalni), protoze

je zbytecnd.

Viditelné znamky koure nebo jiskreni

*  Neprovddéjte zddné kroky pro odstrarfiovan{
problému

*  Pro zajisténi bezpe¢nosti ihned odpojte
monitor od zdroje napdjenf

*  |hned kontaktujte zéstupce sluzeb pro
zékazniky spole¢nosti Philips.

Bl Problémy se zobrazenim

Obraz neni vystredén

*  Upravte polohu obrazu pomocf funkce
JAuto' v OSD Main Controls (hlavnich
ovlddacich prvcich OSD).

*  Upravte polohu obrazu pomoci polozek
Phase/Clock (Faze/frekvence) v ¢asti Setup
(Nastaveni) v OSD Main Controls (Hlavnf
ovlddac( prvky OSD). Tato funkce je platnd
pouze v VGA mode (rezimu VGA).

Obraz se chvéje na obrazovce

» Zkontrolujte, zda je kabel signdlu rddné a
bezpecné pripojen ke grafické desce nebo k
pocftaci.

Dochazi ke svislému blikani

*  Upravte polohu obrazu pomocf funkce
JAuto” v OSD Main Controls (hlavnich
ovlddacich prvcich OSD).

*  Omezte svislé pruhy pomoci polozek
Phase/Clock (Faze/frekvence) v &asti Setup



(Nastaveni) v OSD Main Controls (Hlavnf
ovlddaci prvky OSD). Tato funkce je platnd
pouze v VGA mode (rezimu VGA).

Dochazi k vodorovnému blikani

*  Upravte polohu obrazu pomocf funkce
LAuto” v OSD Main Controls (hlavnich
ovlddacich prvcich OSD).

*  Omezte svislé pruhy pomoci polozek
Phase/Clock (Faze/frekvence) v &asti Setup
(Nastaveni) v OSD Main Controls (Hlavnf
ovlddac(i prvky OSD). Tato funkce je platnd
pouze v VGA mode (rezimu VGA).

Obraz je rozmazany, nevyrazny nebo prilis
tmavy
» Upravte kontrast a jas na obrazovce OSD.

,Dosvit", ,,vypéleni* nebo ,,zobrazeni duchi*

zUstane po vypnuti napajeni.

*  Dlouhodobé neprerusované zobrazenf
nehybného nebo statického obrazu mdze
zpuUsobit , vypaleni" obrazovky, rovnéz
znamé jako ,,dosvit" nebo ,,zobrazenf
duchd”. ,Vypéleni*, ,,dosvit" nebo
,,zobrazeni duchd" je dobre zndmy jev
u technologie paneld LCD. V mnoha
pripadech ,,vypdleni, , dosvit"* nebo
,,zobrazenf duchd" postupné zmizi po urcité
dobé mimo provoz.

* Pred ponechdnim monitoru bez dozoru
vzdy aktivujte spori¢ obrazovky.

*  Bude-li na vasem monitoru LCD zobrazen
nemeénici se staticky obsah, vzdy aktivujte
aplikaci pro pravidelnou obnovu obrazovky.

»  Vé&zné priznaky ,vypdleni”, ,dosvitu" nebo
,,zobrazeni duchd'" nezmizf a nelze je
opravit. Na vySe uvedené poskozeni se
nevztahuje zdruka.

Obraz je zdeformovany. Text je nejasny nebo
rozmazany.
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* Nastavte rozliseni zobrazenf pocitace na
stejny rezim, v jakém se nachdzi doporucené
nativn( rozliSeni obrazovky monitoru.

Na obrazovce se objevuji zelené, cervené,

modré, tmavé a bilé tecky

e Zbyvajicl body jsou normalnf viastnostl
tekutych krystall pouzivanych soucasnou
technologii. Dals$f podrobnosti viz pravidla
pro obrazové body.

Svétlo indikatoru ,,napajeni je prilis silné a rusi
* MdzZete nastavit intenzitu svétla indikdtoru
,napdjeni” v ¢asti Indikdtor LED napdjenf
v Casti Nastaveni v OSD Main Controls
(Hlavni ovlddaci prvky nabidky OSD).

Potrebujete-li dalsi pomoc, viz seznam
Informacni strediska pro zdkazniky a kontaktujte
zdstupce sluzeb pro zdkazniky spolecnosti Philips.

9.2 SmartControl Lite — ¢asté dotazy

OTAZKA 1: Zménil jsem monitor v poéitadi za
jiny a technologie SmartControl
Lite se stala nepouzitelnou, co mam
délat?

Restartujte pocitac a zjistéte, zda
technologie SmartControl Lite
funguje.V opacném pripadé bude
tfeba odebrat a znovu nainstalovat
SmartControl Lite, aby bylo zajisténo,
Ze je nainstalovan spravny ovladac.

Odpovéd:

OTAZKA 2: Technologie SmartControl Lite

drive dobre fungovala, ale nyni

nefunguje, co mam délat?

Odpovéd:  Pokud byly provedena ndsledujict

kroky, bude pravdépodobné nutné

znovu nainstalovat ovlada¢ monitoru.

* Pouzijte jiny graficky adaptér videa

»  Zaktualizujte ovladac videa

+  Cinnosti na opera¢nim systému, napiiklad
aktualizace nebo oprava

*  Spustte sluzbu Aktualizace Windows a
zaktualizujte ovlada¢ monitoru a/nebo videa

*  Operacni systém Windows byl zaveden, kdyz
byl monitor vypnuty nebo odpojeny.



Odpovéd:

OTAZKA 4:

Odpovéd:

Chcete-li ziskat dalsi informace, klepnéte
pravym tlacitkem mysi na My Computer (Tento
pocitac) a klepnéte na Properties (Vlastnosti)
-> Hardware (Hardware) -> Device Manager
(Sprévce zarizen).

Pokud je pod polozkou Monitor uvedeno ,,Plug
and Play Monitor* (Monitor Plug and Play),

je tr'eba provést novou instalaci. Jednoduse
odeberte a znovu nainstalujte SmartControl
Lite.

OTAZKA 3: Kdy? po nainstalovani

SmartControl Lite klepnu na kartu
SmartControl Lite, ani po chvili

se nic nezobrazi nebo se zobraz{
zprava o chybé, co se stalo?

V&3 graficky adaptér pravdépodobné
nenf kompatibilni s technologif
SmartControl Lite. Pokud je

vas graficky adaptér mezi vyse
uvedenymi znac¢kami, zkuste stdhnout
nejaktudlnéjsi ovladac grafického
adaptéru z webovych stranek
prislusného vyrobce.

Nainstalujte ovlada¢. Odeberte a
znovu nainstalujte SmartControl Lite.
Pokud presto nefunguje, graficky
adaptér bohuzel neni podporovan.
Na webovém serveru spole¢nosti
Philips zjistéte, zda je k dispozici
zaktualizovany ovlada¢ SmartControl
Lite.

Po klepnuti na Product Information
(Informace o produktu) se zobrazi
pouze c¢astecné informace, co se
stalo?

Pravdépodobné nemdte k dispozici
nejaktudingsi verzi ovladace
adaptéru grafické karty, kterd piné
podporuje rozhrani DDC/CI.
Pokuste se stédhnout nejaktudingjst
ovlada¢ grafického adaptéru

z webovych strdnek prislusného
vyrobce. Nainstalujte ovladac.
Odeberte a znovu nainstalujte
SmartControl Lite.
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Attention

Theft mode enabled

OTAZKA 5: Zapomnél jsem sv(ij kéd PIN

Odpovéd:

pro funkci Theft Deterrence
(zabezpeceni proti kradezi). Co
mam délat?

Servisni stfedisko Philips mé pravo
zadat legitimnf identifikaci a ovérenf
pro zjistén( vlastnictvi monitoru.
Upozorfiujeme Vvds, ze funkce
ochrany proti krddezi je k dispozici
jako snadnd a bezplatnd moznost.
Za spréavu cisel PIN nese vyhradnf
odpovédnost konkrétni osoba nebo
organizace, kterd ji jmenuje.

Pokud ¢islo PIN zapomenete,
servisnf stedisko Philips jej mdze
pro vds znovu nastavit za nomindlnf
poplatek po ovéreni vlastnictvi.
Upozorfiujeme Vds, Ze na tuto
¢innost se nevztahuji podminky
standardni zdruky.

9.3 Obecné casté dotazy

OTAZKA 1: Kdyz nainstaluji svj monitor, co

Odpovéd:

mam udélat, kdyz se na obrazovce
zobrazi zprava ,,Cannot display this
video mode* (Tento rezim videa
nelze zobrazit)?

Doporucené rozliseni pro tento
monitor: 1920x1080 pri 60Hz.
Odpojte viechny kabely, potom pripojte
pocita¢ k monitoru, ktery jste pouzili predtim.
V nabidce Start opera¢niho systému Windows
vyberte Settings/Control Panel (Nastaveni/
Ovlddaci panely). V okné Control Panel
(Ovlddacf panely) vyberte ikonu Display
(Zobrazeni). Na panelu Display (Zobrazeni —
vlastnosti) vyberte kartu ,Settings” (Nastaveny).
Na karté nastaveni v poli oznaceném , desktop
area" (pracovni plocha) presurite posuvnik na
19201080 obrazovych bodu.

Klepnéte na ,, Advanced Properties” (Upresnit),
nastavte polozku Refresh Rate (Obnovovact
frekvence) na 60Hz a potom klepnéte na OK.



Restartujte pocita¢ a zopakovdnim kroku 2 a 3
oveérte, zda je pocitac nastaven na 1920x1080
pri 60Hz.

Vypnéte pocitac, odpojte stary monitor a
znowu pripojte monitor LCD Philips.

Zapnéte monitor a potom zapnéte pocitac.

tupymi predméty. Pri manipulaci

s monitorem nevyvijejte na povrch
panelu zddny tlak ani silu. Mohlo by
to negativné ovlivnit vase zarucnf
podminky.

OTAZKA 7: Jak Ize &istit povrch monitoru

OTAZKA 2: Jaki je doporuéena obnovovaci LCD?
frekvence monitoru LCD? Odpovéd:  Pro bézné cisténi pouZijte Cisty
Odpovéd:  Doporucend obnovovaci frekvence a mékky hadrik. Pro dikladné
u monitort LCD je 60Hz. V pripadé cisténi pouZijte izopropyl
jakéhokoli ruseni na obrazovce ji alkohol. NepouZzivejte Zddnd jind
mUzete nastavit na 75Hz a uvidite, rozpoustédla, jako etylalkohol,
zda ruseni zmizi. etanol, aceton, hexan atd.
OTAZKA 3: Co jsou soubory .inf a .icm na disku OTAZKA 8: Lze ménit nastaveni barev
CD-ROM? Jak Ize nainstalovat monitoru?
ovladace (.inf a .icm)? Odpovéd:  Ano, nastaven( barev miZete zmé&nit
Odpovéd:  Jednd se o soubory ovladace prostiednictvim nabidky OSD podle
monitoru. Pri instalaci ovladact ndsledujicich krok:
postupujte podie pokynt v + Stisknutim tladitka , OK" zobrazte nabidku
uzivatelské prirucce. Pri prvnf instalaci oSD.
bude potitat pravdépodobné «  Stisknutim tla¢ftka , Sipka dolii” vyberte volbu
poZadovat ovladace monitoru ,Color" (Barva) a stisknutim tla&ftka ,, OK"
(soubory .infa .icm) nebo disk s prejd&te na nastaven( barev. K dispozici jsou ti
ovladaci. Postupujte podle pokynt a nastaven (viz nize).
viozte (doprovodny disk CD-ROM), 1. Color Temperature (Teplota barev):
ktery je soucdsti této sady. Ovladace PHi nastaven( v rozsahu 6500K vypadajf
monitoru (soubory .infa .icm) barvy na panelu ,teplé" s ¢ervenobilym
budou nainstalovany automaticky. barevnym ténem, zatimco p¥i nastaven(
OTAZKA 4: Jak mam upravit rozliseni? teploty 9300K vypadajf barvy na panelu
Odpovéd:  Dostupnd rozlideni urcuje grafickd wstudené” s modrobilym barevnym tonem.
karta/ovlada¢ grafiky a monitor. 2. sRGB: standard pro Zajléténl’lsprévné ‘
PoZadované rozlifeni mizete vybrat prrenosu barev mezi rliznymi zafizenimi
v &sti Control Panel (Ovlddaci (napf. digitdinf fotoapardty, monitory,
panely) systému Windows® v &sti tiskdrny, skenery atd.) L .
Display properties” (Zobrazenf - 3. User Define (Uzivatelské): uzivatel si mize
vlastnosti). zvolit vlastni nastaveni barev upravenim
) cervené, zelené a modré slozky.
OTAZKA 5: Co kdyz se béhem nastaveni
monitoru ztratim prostrrednictvim © Poznimka:
nabidky OSD? Méreni svétla barvy, které vyzaruje predmét pri
Odpovéd:  Jednoduge stisknéte tlacftko OK a zahrivani. Toto méren( je vyjddieno v absolutnim
potom volbou ,,Reset" (Obnovit) méritku (stupné Kelvina). Nizsi teploty Kelvina,
obnovte viechna ptvodni nastavenf napriklad 2004K; jsou Cervené; vyssi teploty, jako
vyrobce. napifklad 9300K, jsou modré. Neutrdln teplota je
OTAZKA 6: Je obrazovka LCD odolna proti bil pri 6504K.
poskrabani? OTAZKA 9:  Lze pfipojit tento monitor LCD
Odpovéd:  Obecné se doporucuje nevystavovat k libovolnému pocitaéi, pracovni

povrch panelu nadmérnym dderdm

pan g stanici nebo poditaci Mac?
a chranit jej pred ostrymi nebo
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Odpovéd: Ano.Viechny monitory LCD
Philips jsou pIné kompatibilnf se
standardnimi pocitaci, pocitaci
Mac a pracovnimi stanicemi. Pro
pripojeni monitoru k systému
Mac muze byt zapotrebi kabelovy
adaptér. Dal3i informace vam
poskytne nejblizsi obchodnf
zastupce Philips.

OTAZKA 10: Jsou monitory Philips LCD
vybaveny technologii Plug-and-
Play?

Odpovéd: Ano, tyto monitory jsou
kompatibilni s technologif Plug-
and-Play v opera¢nim systému
Windows 7/Vista/XP/NT, Mac
OSX a Linux.

OTAZKA 11: Co znamena Ipéni obrazu,
vypaleni obrazu, dosvit nebo
»duch® v souvislosti s panely
LCD?

Odpovéd: Dlouhodobé neprerusované
zobrazeni nehybného nebo
statického obrazu muze zpUsobit
,vypdleni* obrazovky, rovnéz
zndmé jako ,,dosvit" nebo
,,zobrazen( duchl". ,Vypaleni*,
,dosvit"* nebo ,,zobrazenf duchd*
je dobre zndmy jev u technologie
paneld LCD.V mnoha pripadech
,vypdleni”,, dosvit" nebo
,zobrazeni duchd" postupné zmizf
po urcité dobé mimo provoz.
Pred ponechanim monitoru bez
dozoru vzdy aktivujte sporic
obrazovky.

Bude-li na vasem monitoru LCD
zobrazen neménicf se staticky
obsah, vzdy aktivujte aplikaci pro
pravidelnou obnovu obrazovky.

(D Vystraha

Véazné priznaky ,vypaleni*, , dosvitu" nebo
,,zobrazenf duchd” nezmizi a nelze je opravit. Na
vyse uvedené poskozeni se nevztahuje zdruka.

OTAZKA 12: Pro¢ se na displeji nezobrazuje
ostry text a pro¢ maji
zobrazené znaky zubaté okraje?

V4s monitor nejlépe pracuje

pri svém nativnim rozlisenf
1920x1080 pri 60Hz. Pouzivejte
toto rozlisenf pro dosazenf
optimdlniho zobrazen.
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